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Class Description:   This HANDS-ON class will expand your knowledge of Excel tools 
and how they can be used to manipulate data exported from your management system. 
Don't just watch, do it yourself! Bring your laptop loaded with Excel and use the sample 
Excel workbook provided to practice the skills learned during the class. Become a Report 
Rock Star! 
 

• Learning Outcomes:    Expand your knowledge of Excel tools and how they can 
be used to get the information you want. 

• Master powerful Excel tools and Functions to make reporting easier, like =Right, 
=Left, =Date, Concatenate, Replace, Text to Columns, Vlookup and Macros  

• Be the report “Rockstar” in your agency!  Show the boss just how fast and easy it 
is to analyze data using Excel. 

 
Assumptions:  This seminar is based on the following 

TAM Version 11.X 
Microsoft ® Word Version 2007 
 

Table of Contents 
 

Overview ...................................................................................................................... 4 
Filter data ..................................................................................................................... 4 
Left Function (ie, just the Client Code) .......................................................................... 5 
Right Function (ie, just the Policy Sub-Sections) ............................................................ 6 
Concatenate (Combine Data) ....................................................................................... 7 
Annualize Premium or Commission .............................................................................. 9 
Convert Applied Tam Accounting Month/Year into a Real Date .................................... 9 

Text to Columns ..................................................................................................... 10 
Replace .................................................................................................................. 10 
Date Function ......................................................................................................... 11 

Remove Blank Rows from a Worksheet ...................................................................... 11 
Remove Duplicate Rows from Worksheet ................................................................... 12 
Macros ....................................................................................................................... 12 

Developer Tab ........................................................................................................ 12 
Macro Security Settings .......................................................................................... 13 
Record a Macro ...................................................................................................... 13 
Run the Macro ........................................................................................................ 13 

Vlookup ..................................................................................................................... 13 
APPENDIX I ................................................................................................................ 17 

Sample Search-Customers, Policies Current Criteria/Fields .................................... 17 
 

Intermediate Excel  //  PAGE  3 
 

Applied Client Network  |  www.appliedclientnetwork.com 

 



 
 SESSION HANDOUT 
 Intermediate Excel 

 
Overview 
This class will focus on some of the Excel tools that make formatting and analyzing data 
from Applied TAM easier.  When Book of Business, Production or Activity reports are 
exported from Applied TAM, some data can be lost or formatted differently than 
expected.  We’ll start out by learning some of the handy tools that are useful when 
manipulating TAM data, then move on to more complex functions like vlookup and 
macros. 

Filter data   
This is truly one of the handiest features in Excel.  Ffilter your spreadsheet so that certain 
data shows or doesn’t show.  It makes auditing your data a breeze. 
If you run multiple reports that are basically the same, but with slightly different criteria, 
filters may be just what you are looking for.  Run just one report that includes all the 
criteria you want, and then filter the data in Excel.  You can copy and paste filtered data 
to another spreadsheet without taking any of the other data as when working with 
subtotals. 

Filters are super easy to use.  Simply click in a cell on your worksheet, then click on Data  

– Filter.   This puts little dropdown arrows next to your column headers.  If you click 
on one of those arrows, you’ll see a number of choices including (A-Z), (Z-A), (Filters…), 
and then an alphabetized listing of everything entered in that column, and at the bottom 
of the list you may see the words Blanks (if there are any blank cells in the column).   
 
Click on one of the filters, or select multiple filters to analyze your data quickly. 
 
One huge advantage of filtering over subtotaling, is the ability to copy and paste the 
filtered data into a new worksheet or workbook without having to use the Visible Cells 
only tool. 
 
Examples:  Turn on Filter on Sheet “Search-Policies Current-Active” 

• Filter for Blank Policy Numbers 
• Filter for Zero Premium billing screens 
• Filter for Zero Commission Amounts 
• Filter for missing Producer Codes 
• Filter for Producer CJH for Company CHB 
• Copy and Paste the results of each filter to a new worksheet.  
• Name each worksheet accordingly. 

 
WARNING:  The AutoFilter list may not display all the unique visible items in a 
column as expected, if there are more than 10,000 unique items in the list.  
This is a limitation in Excel 2007. 
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Left Function (ie, just the Client Code) 
Problem:  My spreadsheet only contains the Policy Index, but I want to be able to 
subtotal based on the Client Code, so I need a column with just the Client Code.   
 
Solution:  Use the Left Function to copy only the first 7 characters of the Policy Index 
into a new Column. 

• Insert a blank column in the worksheet.  
• Add a Title to this new column – Client Code 
• Place your cursor in the cell below the “Client Code” Header. 

• Now look to the left of the Formula Bar.  Click on the Insert Function icon  

 
• We want to use the function called Left.  If you don’t see it in the list, type the 

word LEFT in the “Search for a function:” box.  Click Go.   

 
• You can now select LEFT in the “Select a function”: box.  Click OK. 

 
• Now you’ll see a Function Arguments box.  Place your cursor in the Text Field, 

and then click on the cell with the Policy Index data. 
• Now click in the Num_chars field.  Enter 7 (because we want to see the seven 

characters on the left side of the selected cell).  Look at the Formula Result.  You 
can see what data will be placed in the field when you click OK (the Client Code).   

 
• Click OK 
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• Click in the new cell, and move your cursor so it’s in the lower right hand corner of 

the cell.  The cursor will change to a + sign.  Now Double Click.  This will AutoFill 
all the cells below with the same formula. 

• Next, we want to convert our formulas in this column to just data.  Highlight the 
column by clicking on the Column Label (B, for example). 

• Now, right click, Copy 
• Then, right click, Paste – Special Values – Now the data is the 7 digit TAM code, 

and not just a formula. 
 
Example:  Insert a column to the right of the Pol_idx, and use the Left Function to 
copy the Left 7 characters of the Pol_idx into the new column.  Name the new column 
“Client Code” 

Right Function (ie, just the Policy Sub-Sections) 
Problem:  My spreadsheet contains all of my billing screens, but I only want to see the 
Policy Indexes that end in “001”. 
 
Solution:  Use the Right Function to copy only the last 3 characters of the Policy Index 
into a new column.  Then use Excel Filters to see the Policy Indexes that end in “001”. 

• Insert a blank column in the worksheet.   
• Add a Header to this new column – Subsection 
• Place your cursor in the cell below the “Subsection” Header. 

• Now look to the left of the Formula Bar.  Click on the Insert Function icon  

 
• We want to use the function called Right.  If you don’t see it in the list, type the 

word RIGHT in the “Search for a function:” box.  Click Go. 
• You can now select RIGHT in the “Select a function”: box.  Click OK. 
• Now you’ll see a Function Arguments box.  Place your cursor in the Text Field, 

and then click on the cell with the Policy Index data. 
• Then click in the Num_chars field.  Enter 3.  Look at the Formula Result.  You can 

see what data will be placed in the field when you click OK.  We entered 3 
because we want the last 3 characters of the Policy Index field, which should let 
us know whether the billing screen is a subsection. 
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• Click OK 
• Click in the new cell, and move your cursor so it’s in the lower right hand corner of 

the cell.  The cursor will change to a + sign.  Now Double Click.  This will AutoFill 
all the cells below with the same formula. 

• Next, we want to convert our formulas in this column to just data.  Highlight the 
column by clicking on the Column Label (B, for example). 

• Now, right click, Copy 
• Then, right click, Paste – Special Values – Now the data is the 3 digit Policy Slot, 

and not just a formula. 
• Turn on Excel Filters, and locate the policy indexes that end in “001”. 
 
Example:  Insert a column to the right of “Client Code”, and use the Right Function 
to copy the Right 3 characters of the Pol_idx into the new column.  Name the new 
column “Subsection”.  Turn on Excel filters and locate the policy indexes that end 
in “001”. 

Concatenate (Combine Data) 
Problem:  In my agency, we add a new policy detail screen when a policy is rewritten, so 
if I am trying to compare one period to another using the TAM policy index, the data is 
inaccurate.   
 
Solution:  Another option would be to compare one period to another using the TAM 
Client Code and the Policy Type.  Combine the two fields using the Concatenate 
Function. 
 
To Concatenate: 

1. Insert a Column in your worksheet.  
2. Add a Header to this new column – Client - Policy Type 
3. Place your cursor in cell below the Header created in Step 2). 

4. Click the Insert Function button , and select Concatenate from the list of 
functions  (if you can see it), or type the word Concatenate in the “Search for a 
function” box. Click Go, and then click OK when you find it in the list. 
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5. A Function Arguments window will open.  Click in each “Text” box, and then click 
on the cell (or enter text) you want to appear.  In the example above, click in the 
Text1 box, and then click in the cell in the Column called “Client Code” on Row 2, 
then click in the Text2 box and type a –, then click in the Text3 box and click in 
the cell in the Column called “Pol_type” on Row 2.  It should look like this: 

 
6. You can see the formula result in the bottom left corner of the window, the 7 digit 

TAM client code, then a - , then the policy type. 
7. Click OK 
8. Click in the cell C1, and move your cursor so it’s in the lower right hand corner of 

the cell.  The cursor will change to a + sign.  Now Double Click to AutoFill all the 
cells below with the same formula. 

9. Next, we want to convert the formulas in this column to just data.  Highlight the 
column by clicking on the Column Label (C, for example). 

10. Now, right click, Copy 
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11. Then, right click, Paste – Special Values – Now the data is the 7 digit Client 

Code-Policy Type, and not just a formula. 
Example:  Combine the TAM Client Code with the Policy Type. 

Annualize Premium or Commission 
Problem:  My Search – Policies Current does not annualize my premium or commissions.   
 
Solution:  Use Excel formulas to calculate the Annualized Premium and Commissions. 
 

1. Insert a column and name it “Days in Force” to the right of the Expiration Date 
column. 

a. Formula is =+F2-E2   (F2 is Expiration Date cell, E2 is Effective Date cell).  
Place cursor in lower right hand corner of the cell, and double click.  This 
will autofill the column with the formula. (The value in the cell looks like a 
date, but we will change it in the next step to be a number). 

b. Select column “Days in Force”, right click Format Cells.   
i. Category:  Number 
ii. Decimal places:  0 
iii. Use 1000 separator 

c. Sort “Days in Force” column in descending order by clicking on a cell in the 

column, click the Data Tab, .  This will sort the column to show you the 
billing screens with the largest effective date range at the top.  Determine if 
the multi-year policies are reflecting the annual premium or the full term 
premium. 

2. Insert a column called “Annualized Commission” next to the “Days in Force” 
column. 

a. Formula is =365/G2*N2   Column G is “Days in Force” and Column N is 
Co_amt.  Place cursor in lower right hand corner of the cell, and double 
click to autofill the column with the formula. 

3. Insert a column called “Annualized Premium” to the right of the “Annualized 
Commission” column. 

a. Formula is =365/G2*Q2   Column G is “Days in Force” and Column Q is 
Prem.  Place cursor in lower right hand corner of the cell, and double click 
to autofill the column with the formula. 

4. For policies in force less than 31 days, Copy and Paste Prem and Co_amt fields to 
Annualized Premium and Annualized Commission Fields if you don’t want these 
commissions or premiums annualized. 

Convert Applied Tam Accounting Month/Year into a Real Date 
Problem:  The TAM Accounting Month is not a true date.  This is a problem when we 
want to Group transactions by Accounting Month or Year in a Pivot Table  
 
Solution:  Use Excel tools to convert that funky month and year to a real date. 
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1. Insert 2 columns to the right of Month column. 

a. Highlight the two columns to the right of the TAM Month Column.  Right 
click on Column.  (This will highlight the columns) 

b. Click Insert.  You will now have two blank columns to the right of the Month 
column. 

Text to Columns 
2. Use Text to Columns to split up month and year into two columns 

a. Highlight the Month column 
b. Click Data – Text to Columns 
c. Choose Fixed Width.  Click Next. 
d. Click between the 2nd and 3rd characters.  A line will appear showing how 

the text will be split.  Click Next. Click Finish. 

Replace 
3. Replace the letter in the two digit year (B2) so you have a four digit real year 

a. Highlight the column with the two digit year. 
b. Click Home, Find and Select from the Editing Tab. 

 
c. Click Replace 

i. Find What:  B 
ii. Replace With:  201 
iii. Click Replace All. 
iv. Repeat for all applicable years in spreadsheet.  
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Date Function 

4. Use the Date Function to combine the Year and Month to create a real date. 
a. In the other blank column created in Step 1, enter a heading:  Month 

5. Click the Insert Function button , and select DATE from the list of functions  (if 
you can see it), or type the word DATE in the “Search for a function” box. Click 
Go, and then click OK when you find it in the list. 

a. Click in the field named “Year”, then click on the cell with the year 
b. Click in the field named “Month”, then click on the cell with the month 
c. Type 01 in field named “Day” 
d. Click OK 

 
 
 

6. If you see a number instead of a date (38777) in the example above, you just need 
to format the cell as a date (currently it’s a number). 

7. Autofill the formula to the remaining cells in the column. 
8. Use the Copy – Paste Special –Values to convert the new date from a formula to 

an actual date. 
9. Delete the columns for the Year and Month.   

 
Example:  Convert TAM accounting month in Production Report to Real Date 
 

Remove Blank Rows from a Worksheet 
1. Select the range of data that contains the duplicate rows. 
2. From the Home tab, Editing Group, click the small arrow next to Find & 

Select.Select Go To Special. 
3. Select the Blanks radio button and click OK. 
4. All blank rows within the selected data range will be highlighted. 
5. From the Home tab, Cells Group, click the small arrow next to Delete 
6. Select Delete Sheet Rows 
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Example:  Insert a couple of blank rows, and then practice removing them. 

Remove Duplicate Rows from Worksheet 
1. From the Data tab, in the Data Tools group, click Remove Duplicates. 

 
2. Notice all the columns are checked, so click Unselect All.  Now click on the 

columns you want to use to remove duplicates. 
3. Click OK, and the duplicate rows will be removed. 

 
Example:  Remove duplicate customer codes since I want to get a customer count, not 
a policy count. 

Macros 
A Macro can save you time by recording keystrokes that can be replayed when you need 
them.   

Developer Tab 
If you don’t see the Developer Tab, Click the Microsoft Office Button, and then click Excel 
Options. Click Popular, and then select the Show Developer tab in the Ribbon check box.   
 

 
 
In Excel 2010 or 2013, go to File, Options, Customize Ribbon, and check the box under 
Main Tabs for Developer, click OK. 
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Macro Security Settings 
To set your Macro Security settings, click on the Developer Tab, Code group, Macro 
Security.  See Microsoft Excel Help for explanations of the various Macro Security 
Settings.  In order for the new Security settings to take effect, you must Close and Re-
open Excel. 

Record a Macro 
Example:  Record a macro to create a column with the 7 digit Client Code from the 
Policy Index, and then combine it (Concatenate) with the Policy Type into another 
column. 

• On the Developer Tab, in the Code Group, click Record Macro.  Give the Macro a 
name (No spaces allowed in the name).  Now, every keystroke you make is being 
recorded, so even if you make a mistake, the correction is being recorded, too! 

• Follow the steps in the LEFT FUNCTION and CONCATENATE sections to insert 
the column for the Client Code and the column for the Client-Policy Type. 

• To stop recording the macro, click on Stop Recording button in the Developer 
tab, Code group. 

• Now delete the new column you just created, and try running your new macro. 

Run the Macro 
From the Developer tab, in the Code group, click Macro.  Select the desired Macro, and 
Click Run. 

Vlookup 
Here’s the scenario:  I’ve got a Book of Business report exported to Excel from TAM.  It 
does not include the Customer Name, just the Policy Index or, if the report was sorted by 
Customer, the Customer Code will be in the Mainsort column with a C in front of every 
Customer Code. 
 
I can insert a Column, and use the Left function on the Pol_idx column.  That’s great, but I 
still don’t have the Customer Name on the spreadsheet.  Here’s where the VLOOKUP 
function comes in. 
 
Run a Search from TAM that includes the Customer Code AND the Customer Name.  This 
can be done from a Search-Customers, Main File.  For this example, only include the 
Customer Number and Customer Name as the Selected Fields.  When the Excel file 
opens, copy and paste the data found in the Search into another worksheet in the 
workbook containing the Book of Business report.  Now you have the Book of Business 
report and the Search-Customers, Main File report in the same workbook.   
 
In your sample workbook, the Sheet named “Vlookup BOB” is our Book of Business 
Report exported to Excel, and  “Vlookup-Name” is the table of data (the table array).  
This is the sheet that has the information (Customer Name) we want to put on the Book 
of Business report 
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Note: Before using VLOOKUP, make sure the table of data (the table_array) is sorted in 
ascending order (alphabetically A to Z).  

Here’s how the vlookup sheets in the sample workbook should look now: 
 

  
 

 
In this example, the VLOOKUP function will compare the value in cell C2 on the 
“Vlookup-BOB” sheet to the values in Column A of the “Vlookup Names” sheet.  When 
it finds an exact match, it will enter the value that was found in Column B of “Vlookup 
Names” sheet (the Customer Name) into the designated cell (Column D) on the 
“Vlookup-BOB” sheet. 
 

1.  Insert a Column to the left of Column D in on the “Vlookup-BOB” sheet.  

  
2. Click the Insert Function button , and select VLOOKUP from the list of 

functions  (if you can see it), or type the word VLOOKUP in the “Search for a 
function” box. Click Go, and then click OK when you find it in the list. 
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3. A Function Arguments window will open.  Place your cursor in the Lookup_value 

field, and then click on cell C2 (the first Client Code listed on the “Vlookup-BOB” 
sheet). 

 
 

4. Place your cursor in the Table_array field, then click on the Sheet named 
“Vlookup Names”, and click and drag to select Columns A and B.  . 

  
5. Place your cursor in the Col_index_num field and enter 2.  This is telling Excel that 

the value we want (the Customer Name) is in Column 2 on the Sheet named 
“Vlookup Names” 
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6. In the Range_lookup field, type FALSE.  This means if there is no match found, 

you will see #N/A in the field. 

 
 

7. You can see the formula result (the Customer Name) in the bottom left corner of 
the window. 

 
 

8. Click OK 
9. Autofill the formula into all the cells below cell D2 by placing your cursor in the 

bottom right hand corner of the cell.  When the cursor changes to a black plus 
sign, double click.  This will copy the vlookup formula into all the cells below. 

10. If you’d like to convert the formula to the actual text, use the Copy – Paste Special 
Values tool. 
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APPENDIX I 

Sample Search-Customers, Policies Current Criteria/Fields 
1. From TAM Homebase, Click Reports – Search 
2. Search – Customers 
3. Policies – Current 
4. Output Destination – Excel-Raw Data

 
5. Criteria Tab 
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a. Policy Status – Only ACTIVE policy statuses (NEW, REN, REI, REW – 

whichever codes YOUR agency uses) 
b. Expiration Date – You might want to limit the Expiration Date range to 

include only billing screens that are expiring after the month you are 
closing.  For example, if you are running the report at November 30, 2009, 
choose an Expiration Date range of 12/01/09 thru 11/30/2015.  This will keep 
all the old billing screens with inaccurate policy statuses from skewing the 
report, but include all expiration dates in the next six years. 

c. Record Listings – Choose “List Each Time Found”, and then manipulate in 
Excel to get only the commission and premium on the main package or on 
the subsections. 

6. FIELDS/SORT (Include as many as desired, but be consistent each month) 
Field Name Excel Column Title 
Customer/Pol_idx Number Pol_polidx 
Agency Pol_agcy 
Branch Pol_brch 
Department Pol_dept 
Policy Number Pol 
Policy Effective Date Effective 
Policy Expiration Date Expires 
Date First Written Fwritten 
Policy Type Pol_type 
Policy Type Group Typegroup 
Issuing Company Ico 
Billing Company Bco 
Type of Agency Commission Co_type 
Total Commission Amount Co_amt 
Total Commission % Com_p 
Billing Mode Bill 
Producer One Pr1 
Producer One Comm % Pr_p 
Producer One Comm $ Pr_amt1 
Producer Two Pr2 
Producer Two Comm % Pr_p2 
Producer Two Comm $ Pr_amt2 
Producer Three Pr3 
Producer Three Comm % Pr_p3 
Producer Three Comm $ Pr_amt3 
Policy Premium Prem 
Policy Status Pol_status 
Policy Customer Service Rep Pol_csr 
Customer Number Cust_rec 
Customer Name Cust_name 
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7.  When finished selecting fields, click Run. 

8.  Always choose the 3rd radio button to “Send output to 
a temporary file”.  Click OK 

9.  Click “Yes” to create a new temporary file. 

10.  Click “Yes” to Load Excel. 
• Excel will open with your Billing Screen data.   
• SAVE EXCEL REPORT. 

a. Suggestion:  Save the report each month to a folder called Active Billing 
Screens.  Name each file using the format:  ABSYearMonthDay 

November, 2013 would be ABS2013_11_30 
December, 2013 would be ABS2013_12_31 

This way all the billing screen “snapshots” will be in chronological order in 
the Active Billing Screen folder. 
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